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Headers and Footers
Lesson Plan

A student with moderate knowledge of Microsoft Word learns how to use the header and footer features.


Lesson Objectives
At the end of the class, the student will:
· Know how to insert page numbers.
· Be able to navigate between headers and footers and the body of a document. 
· Understand the basics of what a template is and how to make one.
· Understand how to fix the weird Different First Page anomaly.


Lesson Prep Work
(30 min, at a minimum, prior to student arrival)
· get in early to test for technology failure, because it will happen :-).
· Move the following files to the desktop on each computer. 
· Headers and Footers letter.docx
· Headers and Footers Logo.gif
· print handouts.


Lesson Prerequisites
· Microsoft Word Basics plus practice time or equivalent skills.
· Microsoft Word: Images and equivalent skills preferred


Lesson Outline
The lesson is completed in one 60 minute class session.
5 minute Introduction
· Introduce instructor, students.
· Ask students at introduction: Who has used Word before? What have you used it to do? 
· Let students know it’s okay to take phone calls, but ask them to put their phone on vibrate and answer calls outside the classroom.
· Inform students that they can sit back and watch if the class is too advanced.
· Inform students they can go to the bathroom, they don’t need permission.
· Show order in which class will happen. Explain scope of class.



(5) Vocabulary 
· Activity: Open a New Word document.
· Introduce the Ribbon Interface.
· Tabs - the currently active tab is the one that is highlighted. If students see a different menu on their screen during the course of the lesson, they can always look to see which of my tabs is highlighted to find the options I am displaying.
· Home Tab – where your most frequently accessed features lived. On this tab you can edit your font, your paragraph alignment and more.
· Insert – Add anything beyond basic text to the page. 
· The other tabs all have specific and wonderful purposes, but to uncover the mystery of them, I encourage students to attend another class that covers them.
· Groups – These are to narrow down where your looking for a button when I give instructions. If I tell you to click on the Font Size menu, I’ll identify that it is in the Font group so you can find it easier.
· What is a Header?
· A Header is a section of a document that appears in the very top of the page. 
· It can be a repeating object and appear on every page, or be a single use object that only appears on the first page.
· It can be images, text or anything else you can include in a Word document.
· What is a Footer?
· The only difference between a Header and a Footer is where it appears. The Footer is located at the bottom of the page.
· Teacher’s Tip: Feel free to list examples of headers and footers at this point in the class. I have has mixed luck with this because many students still don’t understand what the difference between typing something in the header/footer is and the rest of the document.
· How do to they relate on the page?
· The header and footer are separate portions of the document.
· Draw a piece of paper on the white board and show dashed lines to segment off the header and footer.
· They do not interact with the text on the rest of the page. 
· If, for example, I put a page number in the footer, then type a bunch of text in the body, the page number doesn’t keep moving down the page. It’s sectioned off.

(5) Insert a Footer
· Explanation
· The most commonly used footer is going to be page numbers. But footers can be used for other purposes as well. Let’s start with page numbers then take a look at other things we may want to appear in our document.
· Activity: Insert Page Numbers 
· Step 1 – Click on Page Number in the Header & Footer group on the Insert tab.
· Step 2 – Hover on Bottom of Page to have your page numbers appear at the bottom of your document.
· Step 3 – Scroll thru the options so students know how detailed they can go. I am going to click on Accent Bar 2 for my document. 
· We get a new tab in our ribbon called the Header & Footer Tools tab. This tab allows us to further edit our headers and footers.
· The page number has appeared at the bottom of the page. 
· There is a dashed blue line that shows the sectioned off header at the top and footer at the bottom. 
· We cannot edit our document from this point, only our header and footer. Try to click to type in text in the top of the page but below the header marking. You cannot click there to add in text.
· Activity: Move between Editing Document and Editing Footer. 
· Step 1 – Exit the footer and get back to where you can type in the document by double clicking in the white space below the header line. 
· The Header & Footer Tools tab disappears when we aren’t editing our header or footer.
· Step 2 – Type in BATMAN RULES! In the body of the paper. Try to click on our page numbers to edit our footer again; we aren’t allowed to. 
· Ask students: “When we had this issue in our footer, what did we do to get back to add text to the body of the document?”
· We double clicked where we want to go!
· Step 3 - Double click on your footer. 
· The Header & Footer Tools tab re-opens.
· BATMAN RULES! is now grayed out and we can’t edit it.

(15) Insert a Header
· Insert Text
· Explanation
· Ask students: “What is the difference between a header and a footer?”
· The location on the page.
· Ask students: “What kind of stuff might you find in a header?”
· Company contact info.
· Company logos.
· As well as anything you might find in a footer!
· Activity: Add text to the header. 
· Bring up a Word document with this text on it: 
Batman Industries
Gotham City, USA
1-225-522-8626

· Ask students to type this in their headers and make the font Verdana size 12 and bold. 
· Students can work independently as you walk around the room to assist. Give them 3 – 5 minutes depending on skill level.
· Activity: Move between Editing Document and Editing Header. 
· Ask students: “How do I get back to the main body of the document so I can continue typing my letter?”
· Step 1 – Double click in the white space below the header line. 
· The Header & Footer Tools tab disappears.
· Ask students: “How do I get back into my footer to edit my footer again?”
· We double clicked where we want to go!
· Step 2 - Double click on your header. 
· The Header & Footer Tools tab re-opens.
· Insert a Logo
· Explanation
· Ask students: “Besides contact information, what else do companies usually put into a letterhead?”
· The logo!
· Let’s take a quick look at using images in our header. If you have further questions after this session about image manipulation, check out our MS Word: Images class the next time it’s taught.
· Activity: Insert the Company Logo. 
· Step 1 – While you have the header selected (you can see the Header & Footer Tools tab), click on Picture in the Insert group.
· Students can also get to the Picture button on the Insert tab, but it’s duplicated here. We’ll use the one on the Header & Footer Tools tab. 
· Step 2 – Use the dialog box to find Company Logo.gif on the desktop. Select it and click on Open.
· Step 3 – The image will automatically be added wherever your insertion point appears. Start by shrinking the image down to a smaller size. 
· Step 4 – The image stays in line with the text. If you click and drag on the image to move it to the right, nothing happens. Inform students that we need to perform a process called a text wrap. 
· Step 5 – Ask students: “what do you see that is different about the ribbon when we have the image selected?”
· Picture Tools Format tab: tools to edit and manipulate our images.
· Step 6 – Click on Text Wrapping in the Arrange group. Select the square style. 
· Step 7 – Further shrink the image to fit inside the header.
· Comprehension Check: What are contextual tabs? 
· Step 1 - Click off the image. Ask the students: “What changed about our ribbon now?”
· The Picture Tools Format tab went away.
· Both the Picture Tools Format tab and the Header & Footer Tools tabs are contextual tabs. They aren’t always present. They only appear when they will actually be useful. If you aren’t editing an image, you don’t need image editing tools.
· Step 2 – Ask students: “What will bring the image editing tools back?”
· Click on the image! 
· Just like you have to highlight text to edit it in Word, you have to select an image to edit it. To select an image, click on it. 
· Activity: Move Between Editing Document and Editing Header. 
· Ask students: “How do I get back to the body so I can type my letter?”
· Step 1 – Double click in the white space below the header line. 
· The Header & Footer Tools tab disappears.
· Ask students: “How do I get back into my footer to edit my footer again?”
· We double clicked where we want to go!
· Step 2 - Double click on your header. 
· The Header & Footer Tools tab re-opens.

(5) Create a Template
· Explanation
· Think of the pads of paper you see when you stay at a hotel. Each sheet contains the name of the hotel, the address, the phone number, the web address, the email address, etc. When you take a note and rip off the top page, they don’t want to have to come back to the room to rewrite all that information on the pad. The next page already has it. That’s what we’re creating when we make our own template.
· Templates are time savers. Rather than having to re-create this document every time you wanted to create an official company letter, you can open a blank document that already has all the important and repetitive information in it.
· For more information on templates come to the Word: Templates class.
· Activity: Save the document as a template. 
· Step 1 – Click on the File tab and select Save As.
· Step 2 – Click on Browse and select Desktop.
· Step 3 – Title the document Letterhead.
· Step 4 – Use the Save As Type dropdown menu to select Word Template (*.dotx). 
· Step 5 – Click Save.	The document title bar now says Letterhead.dotx.
· Step 6 – Close out of the document entirely. 
· Step 7 – Open the document from the desktop.
· The title bar now says Document 1.docx. This means it is a new blank document that has never been saved to this computer.
· Comprehension Check: Ask students: “So, what is the benefit of saving this file as a template rather than just as a Word document”. Write their answers on the whiteboard. Fill in the answers they don’t give. 
· Letterhead will look the same every time.
· Someone else can’t come in and accidentally change the document. 
· Someone else can’t save another document they are working on over the blank letterhead.

(10) Dealing with longer documents
· Adding Text to the Body
· Explanation
· Since today’s class is on using the header and footer tools in Word, we don’t want to spend a lot of time worrying about typing in text. Fortunately, the brilliant instructor prepared a document so we can copy and paste in text so we can practice working with headers and footers in longer documents. 
· Activity: Copy and Paste text from Headers and Footers letter.docx. 
· Step 1 – Open Headers and Footers letter.docx. 
· Step 2 – Select all the text by clicking and dragging.
· Step 3 – Right click on the text to bring up your options menu.
· Step 4 – Select Copy.
· Step 5 – Go back to Document 1 with your letterhead setup on it.
· Step 6 – Right click in the blank body portion of the page. 
· If you right click in the header space, you get an option to Edit Header, not the normal options menu.
· Step 7 – Select Paste.
· Create a Different First Page Header
· Explanation
· We have two pages of text on our letterhead. The only problem is, the logo and contact information appear on both pages… 
· Ask students: “What if I only want that information on page 1?”
· Activity: Set First Page to be a Different Header. 
· Step 1 – Ask students: “Now I want to edit my header. What is the first thing I need to do?”
· Double click in the header! 
· Now the header is active and the body text is grayed out. Again, you cannot edit the body text when you have your header active.
· It also brings up the Header & Footer Tools tab. 
· Step 2 – Click in the checkbox for Different First Page in the Options group of the Header & Footer Tools tab.
· Everything disappeared from the first page, but stayed on the 2nd. If we had more pages in the document, all subsequent pages would have the company logo and contact info.
· Since we want the exact opposite of this, we need to do a cut and paste of the page 2 header and put it on page 1.
· Step 3 – Click and drag to select your Batman Industries header.
· Step 4 – Right click on the text.
· Step 5 – Select Cut. 
· Cut is similar to copy but with one major difference. Copy leaves the original text in place to be accessed again. Cut removes the original text like you had used the backspace key.
· Step 6 – Right click in the header on page 1.
· Step 7 – Select Paste.
· Comprehension Check: Insert the page number on page 1. 
· When we made the first page different from the other pages, it didn’t just delete the information in the header. We also lost our page numbers in the footer. 
· Ask students to work independently or in groups to figure out how to get their page numbers back into their page 1 footers.
· Instructor walks around the room to help people who are lost while they are working on adding page numbers to page 1.

(10) Homework
· Explain:
· Students are expected to practice for at least 2 hours for each class.
· Every library has both internet and Word on their computers. Please practice at a location that is convenient for you!
· Word tutorials at gcflearnfree.org. 
· Step 1 – Go to gcflearnfree.org.
· Step 2 – Click on the Microsoft Office tile.
· Step 3 – Click on Word 2013.
· Step 4 – Assign the tutorial on Headers, Footers, and Page Numbers.

(5) Conclusion 
· Go over handout, review material, and emphasize contact info & further resources on handout.
· Any questions? Final comments?
· Remind patrons to practice; assign take-home-practice - remind them they can ask for help
· Remind to take survey.
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